
 

  

BricsCAD 3D Modeling 
Training 



1 
 

Contents 

Introduction .............................................................................................................................. 1 

Interface, viewing and navigating .................................................................................................... 2 

Exercise 1: Basic concepts ........................................................................................................... 12 

Exercise 2: Sculpting a model ....................................................................................................... 15 

Exercise 3: Mechanical Parts ........................................................................................................ 23 

 

Introduction 
1. The step-by-step instructions also have figures included to provide additional context for select steps  

2. Modules have “starter .dwg files” that should be used 

3. The text in “bold blue” indicates BricsCAD commands 

4. The text in “bold black” are inserted and/or selected values  

5. The exercises are in metric units (mm) 

 

Before beginning, make sure the following settings are enabled: 

- In the Status Bar (bottom right of your screen): ESNAP, STRACK, DUCS, DYN, QUAD, RT 

- In the Command Line: DMEXTRUDEMODE = 3, BIMOSMODE = 1, QUADDISPLAY = 5, (optional - for better on-screen rendering) 

ANTIALIASSCREEN = 2 

- In the Ribbon, under Home tab (Can also be done in the Command Line: SELECTIONMODES = 6) 

o Disable selection of Edges 

o Enable selection of faces 

o Enable selection of Boundaries 

- In the Structure Browser Configuration Window: ‘Select entities when selected in tree’ 

 

 
 This document can be used by Bricsys Partners to create their own localized BIM training. Bricsys only requests to receive the localized 

content when finalized. 
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Interface, viewing and navigating 

 

This module explains BricsCAD V21 interface, shows how to show and hide (selected) entities, make 

sections and how to navigate in 3D. 

 

1 Interface 

 

 

1.1 BricsCAD Launcher 

When starting BricsCAD, the Launcher dialog 

appears. Here you can select your workspace. 

Since our training is for BIM we will select the BIM 

workspace. 

 

   

1.2 Getting Started 

In V20 the welcome window, you have 3 main 

sections (1) HOME, (2) LEARN and (3) 

APPLICATIONS. 

1. From the HOME tab you can create a new 

drawing, choose your units, open a drawing or 

access your most recent files. 

2. From the LEARN section you can access 

tutorials 

3. From the APPLICATIONS section you can 

explore third party applications 
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1.3 New Drawing 

Before starting a New File, check that you use the 

BIM-mm template. You can change it by scrolling 

down through the Templates and selecting BIM-

mm 

 

NOTE: Once the model space appears, check that 

the settings are according to the one mentioned in 

the introduction. 

 

1.4 File Menu 

The FILE menu can be accessed through the 

BricsCAD icon, in the top left corner of the ribbon 

      

  

1.5 Dark Interface 

BricsCAD is set by default to have a Dark Interface, 

but this can be easily changed by right-clicking 

anywhere in the ribbon or toolbar, and de-selecting 

Dark Interface 

 

 

 

 

 

 

    

1.6 Workspaces 

Switching between workspaces can be done from 

the status bar. If you right-click on the tab 

displaying BIM, the list of different workspaces will 

be displayed. 

 

TIP: You can also access the Workspaces by right-

clicking anywhere in the ribbon or toolbar 

 

 

 

1.7 Access Toolbar 

BricsCAD Access toolbar at the top of your screen 

acts as an Express Toolbar. Here you will find the 

most used tools when 3D modelling. 
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You can access this toolbar by right-clicking in the 

ribbon, selecting toolbars, then BRICSCAD and 

Access3D 

 

 

 

1.8 Ribbon Tabs 

Common tools are organized in groups within tabs. 

Each tab corresponds to a group of functionality  

 

1.9 Drawing Tabs 

This allows you to easily switch between different 

open drawings. 

 

TIP: You can also display all open drawings at once 

by right-clicking on any of the project tabs and 

selecting to view horizontal or vertical 

 

 

 

1.10 Model Tab 

Model Space is an area in which you create two-

dimensional and three-dimensional entities based 

on either the World Coordinate System (WCS) or 

User Coordinate System (UCS).  

 

1.11 Layout Tab 

Layout tab can also be referred as paper space. 

Here is a work environment that provides the 

model space view at a given scale, depending on 

the size of the paper 
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1.12 Collapsible panels 

A set of collapsible panels is shown on either side 

of the screen. In the BIM workspace, by default the 

Structure browser, Project browser and BCF Panel 

are pinned to the left-hand side. On the right-

hand side you will find the Tips, Properties, 

Components, Details, Compositions, Profiles, 

Layers, Mechanical browser and 24/7 Panel. Most 

of these will be covered later in this document. 

        

1.14 Commandline 

In the lower field, you can type the commands and 

BricsCAD shows prompt, options and other 

information regarding the execution of commands 

here. Press F2 to show the full command prompt in 

a separate window, or Shift + F2 to show/hide the 

commandline. 

 

1.15 Status Bar 

The Status Bar sits along the bottom edge of the 

BricsCAD application window. It contains a lot of 

information about the settings in the current 

drawing. 
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2 Viewing  

If you work with many entities in a drawing, everything that you have in the drawing is visible in the view. When you 

want to temporarily make only a few entities or a particular entity visible and manage them in a view, you can use the 

Hide or Isolate tools. 

 

2.1 File: Select Template: BIM mm. Then click on 

Open drawing. Select file Building_M1.dwg 
 

2.2 Hiding Entities 

The Hide tool temporarily hides the selected 

entities in the view. 

 

In this drawing we will hide the windows from the 

right building 

1. Select windows 

2. Quad appears, move cursor to Select tab and 

click on HIDE ENTITIES icon  

 

All entities that have been selected are hidden in 

the view. 

 

 

 

 

 

 

2.3 Isolating Entities 

The Isolate tool temporarily hides all entities except 

those that have been selected. 

 

In this model, 

1. Select the front windows from the left building 

2. Once the quad appears go to Select tab and 

click on ISOLATE ENTITIES  

 

All entities that have been selected are temporarily 

isolated. 
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2.4 Showing entities 

The Show Entities tool brings back all hidden 

entities in the view. 

 

Let’s bring all entities back to view 

1. Right-click in the model space. The quad 

appears in no selection state 

2. Move cursor over the General tab and click on 

SHOW ENTITIES  

 

All entities that were temporarily hidden and 

isolated will be shown. 

 

 

 

 

 

2.5 Structure Browser 

The Structure Browser can also be used to hide and 

isolate selected entities as well as revealing all 

hidden entities in the model space. 

1. Open the Structure Browser 

2. Make sure the current configuration is set to 

bim. If not, click the little hamburger menu on 

the top right corner of the structure browser. 

3. Select Wall elements. All entities under this 

element will be selected 

4. Right-click and select Hide 

 

All the walls have been temporarily hidden. 
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NOTE: Make sure the settings for the structure 

browser are correct by clicking on the name Bim 

on top of the structure browser. You will enter a 

dialog where you need to go to the Options tab. 

There you need to choose the preset Select 

entities when selected in tree from the 

dropdown. 

 

 

 

 

3 Navigate in 3D  

As you navigate around and through your 3D model, the location of the model in space remains constant. It’s your 

current view (viewpoint) of the model that is changing.  

 

3.1 Mouse and Keyboard Navigation 

Most used navigation tools are the zoom in/out, 

pan and orbit which can be easily accessed through 

the mouse and keyboard. 

1. Zoom in/out – roll the mouse wheel 

2. Pan – hold the mouse wheel or middle mouse 

button 

3. Orbit – hold Shift key and mouse wheel 

 

3.2 View Ribbon Tab 

Extra zoom, panning and orbit tools can be found 

in the View Tab from the ribbon tool 
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3.3 Look From Navigation Tool 

The LookFrom tool is displayed in the upper right 

corner of the Drawing area. 

 

Click on different places on the LookFrom tool to 

display the view from standard viewpoints. 

 

TIP: To view Bottom viewpoints hold Ctrl key. 

 

NOTE: A right-click menu offers access to 

additional controls and settings. To learn more, 

refer to BricsCAD Online Help. 

 

 

 

 

3.4 Properties Panel 

Extra view settings can also be found in the 

Properties Panel while nothing is selected. 

 

1. PERSPECTIVE: Reports the current value of the 

PERSPECTIVE system variable; 

switches perspective view mode on and off. 

2. VISUAL STYLE: Reports the current visual style, 

and allows you to select a different one. 

1 

  

   

   

 

1 

2 
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4 Selecting entities and Quad cursor 

The following steps will demonstrate how to work with the Quad Cursor and highlight & select 3D model entities. 

 

4.1 File:  New, select Default-cm template. Note 

that the drawing units of this file will be in 

centimeters. 

 

4.2 Using the Quad 

The quad is a floating toolbar that adjusts its 

content, depending on what you are or are not 

highlighting, and what you may have selected in 

the current workspace 

 

We’ll start with an empty drawing 

1. Right-click in the model space. The quad 

appears in no selection state 

2. Move the cursor over the Model tab  

The tool group is expanded with more tool 

options 

3. Click the BOX icon from the quad 

4. Draw a simple 3D box 

5. Hover the cursor over one of the faces of the 

box. The Quad displays a single icon, which is 

the most recently used tool with this entity 

type.  

6. Right-click to launch the most recently used 

tool or move the cursor over the icon to 

further expand the Quad 

 

  

 

 

 

4.3 Selection modes  

Selection modes allow you to control which sub-

entities (faces, edges, and boundaries) should 

highlight in selection preview, and can be 

selected.  

1. Selection modes can be found in the Access 

toolbar or by typing SELECTIONMODES in 

the command line. 

2. Click the face and boundaries options. 

Select edges is inactive whereas select faces and 

select boundaries are active 

. 

 

Enable 

detection of 3D 

solid edges  

Controls whether 3D solid edges are 

highlighted by selection preview, and 

can be selected.  

Enable 

detection of 3D 

solid faces   

Controls whether 3D solid faces are 

highlighted by selection preview, and 

can be selected.  

Enable 

boundary 

detection   

Controls whether closed boundaries 

in XY-plane of the current coordinate 

system or on the face of 3D solids are 

detected.  
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4.4 Highlighting vs Selecting entities 

 

When select Edges is off, select Faces and 

Boundary Detection are on (default), do one of 

the following:  

1. Hover over the face with your mouse cursor 

The solid face is highlighted in orange. When 

the face is highlighted, click this face to select 

it 

2. Hover over one of the faces of the solid while 

holding down the CTRL key 

The solid displays in blue. When the solid is 

highlighted, click the solid to select it 

3. Hover over the edge of the solid while 

holding down the CTRL key. The edge 

displays in blue. When the edge is 

highlighted, click the edge to select it 

Highlighted/Selected 

Face 

 

Highlighted Solid 

 

Selected Solid 

 

Highlighted/Selected 

Edge 

 
 

4.5 Selecting multiple entities with selection 

windows 

The selection windows allow you to select one or 

more than one entity at a time 

There are two types of selection windows in 

BricsCAD; 

Blue selection window: It appears when creating a 

window from left to right  

Green selection box: It appears when creating a 

box from right to left 

1. Click and move the mouse to the right to 

create a blue window around the box 

geometry you’ve created before. When the 

box is completely inside the window, it will be 

added to the selection set 

NOTE: by default, selection window only selects 

entire entities (e.g. solids, lines, polylines, blocks…) 

but not sub-entities (e.g. solid faces, solid) 

2. Press CTRL key once during window selection 

to select faces of the 3D box 

3. Press CTRL key twice during window 

selection to select edges of the 3D box 

4. Click and move the mouse to the left to 

create a green window around the box 

geometry 

When the box overlaps the window or is 

completely inside the window, it will be added to 

the selection set 

 

To select faces or edges of the 3D box with the 

green selection box, follow the same process as 

the blue selection box. 

 

,    
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Exercise 1: Basic concepts 

 

The following module is to get familiar with basic modeling tools. 

 

1 The Basics 

 

1.1 File:  New, select Default-cm template. Note 

that the drawing units of this file will be in 

centimeters. 

Make sure you are in the Modeling workspace.  

Switching between workspaces can be done from 

the status bar. If you right-click on the tab 

displaying BIM, the list of different workspaces will 

be displayed. Click on Modeling to switch. 

 

 

1.2 Creating a project folder 

Before beginning, save the file in a new folder. 

This will be your project folder where additional 

documents will be saved.  

 

 

1.3 Drawing a box 

1. Open the No-Selection Quad by right-clicking 

on an empty place in the canvas and moving 

the cursor over the icon 

2. Under the Model tab, click the BOX icon  

3. You are prompted: Set corner of box or 

[Center]: 

4. Type in 0,0,0 and press Enter 

5. Two dynamic dimensions are displayed that 

control the length and width of the box (see 

image). The dynamic dimension that is 

highlighted in blue is the active one.  

6. Type in a value of 1000 and press the Tab 

key to switch to the other dynamic dimension 

7. Note that the first dimension is now 

highlighted in pink. This is to indicate that a 

value was entered here, and this value is now 

locked on this dynamic dimension. 

8. Type in a value of 1000 and press Enter. 

Alternatively, you can press Tab again to 

switch back to the first dynamic dimension 
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9. Finally a dynamic dimension appears that 

controls the height of the box. Type in a 

value of 1000 and press Enter. 

 

1.4 Manipulating a face 

1. Move your cursor over a side face of the box 

until it is highlighted 

2. Open the Quad by moving your cursor over 

the icon 

3. Under the Model tab of the Quad, click the 

PUSHPULL icon  

4. Type in a value in the dynamic dimension 

box and press Enter, or left-click on the 

location where you want to pull this face to. 

 

 

 

1.5 Manipulating multiple faces 

1. Select a side face of the box by left-clicking it 

2. Select the top face of the box 

3. When you have both faces selected, right-

click anywhere on an empty space in the 

canvas to open the Quad 

4. Under the Model tab, click the PUSHPULL 

icon  

5. Both faces will now be pushed in or pulled 

out over equal distances.  

6. Type in a value and press Enter or left-click. 

 

 

1.6 Copying a solid 

1. Highlight the box by holding the Ctrl key and 

hovering over one of the faces of the box. 

Instead of the face, the entire solid should be 

highlighted now. 

2. Open the Quad by moving your cursor over 

the icon, and under the Modify tab, click the 

COPY icon  

3. You are prompted for a Base Point. Left-click 

one of the corners of the box. 

4. You are prompted for the Second point. Left-

click where you want the copy of the box to 

be. 

5. You can continue placing copies, or press 
Enter or Esc to exit the command. 
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Note that the above steps can also be done using 

BIMCOPY after highlighting a face of a 3D solid. 

 

1.7 Manipulating an edge 

1. Highlight an edge of the box by holding the 
Ctrl key and hovering over one of the edges 

of the box. Instead of the face, the edge 

should now be highlighted. 

2. In the Quad under the Model tab, click the 

FILLET icon  

3. Type in a fillet radius and press Enter. 

 

 

1.8 Manipulating multiple edges 

1. Instead of giving one edge a fillet, we will 

fillet all the edges of the box at once 

2. Press Ctrl + Z to undo your previous action, 

so the fillet of the previous step is removed. 

3. Create a selection window around the entire 

box, and while drawing this window, press 

the Ctrl key twice until a small icon indicating 

‘edge selection’ appears (see image) 

4. You should now have selected all 12 edges of 

the box. In the Quad under the Model tab, 

click the FILLET icon  

5. Type in a fillet radius and press Enter. 
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Exercise 2: Sculpting a model 

 

The following steps will give an example of how to turn a simple volume study into actual building 

geometry. You will learn some basic modeling tools along the way 

2 Sculpting a model   

2.1 File:  New, select Default-cm template. 

Note that the drawing units of this file 

will be in centimeters. 

Make sure you are in the Modeling 

workspace.  

Switching between workspaces can be 

done from the status bar. If you right-click 

on the tab displaying BIM, the list of 

different workspaces will be displayed. 

Click on Modeling to switch. 

 

Note: After creating a new drawing from 

the template make sure you do Save As. 

Look for a location easy to find and give it 

a name (ex. Exercise 2) 

 

2.2 Drawing a box 

1. Open the No-Selection Quad by 

right-clicking on an empty place in 

the canvas and moving the cursor 

over the icon 

2. Under the Model tab, click the BOX 

icon  

3. You are prompted: Set corner of box 

or [Center]: 

4. Type in 0,0,0 and press Enter 

5. Two dynamic dimensions are 

displayed that control the length 

and width of the box (see image). 

The dynamic dimension that is 

highlighted in blue is the active one.  

6. Type 5000 for the x-axis and press 

the Tab key to switch to the y-axis 

dimension. 

7. Note that the first dimension is now 

highlighted in pink. This is to 

indicate that a value was entered 
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here, and this value is now locked 

on this dynamic dimension. 

8. Type in a value of 1400 and press 

Enter. Alternatively, you can press 

Tab again to switch back to the first 

dynamic dimension 

9. Finally, a dynamic dimension 

appears that controls the height of 

the box. Type in a value of 2200 and 

press Enter. 

 

2.3 Manipulating the basic shape of an 

object 

1. We want to rotate some faces of the 

box to create a more interesting 

shape. To do this, make sure Face 

Detection  is enabled. 

2. Hover over the end face of the box so 

that it is highlighted in orange, and in 

the Quad under the Model tab click 

ROTATE  . 

3. A yellow widget appears that 

indicates the rotation direction and 

axis. Move your cursor close to the 

bottom edge of the face, until the 

widget ‘rotates’ around that edge. 

4. Move your cursor to the right so that 

the face rotates ‘outwards’,  

type in 10 and hit Enter. 

5. Do the same for the top face:  

rotate it 10 degrees downward 

around its left edge (see image). 

6. Do the same for the opposite end 

face of the box: rotate it 15 degrees 

outward around its bottom edge 

(see image). 

7. In the end, you should end up with a 

shape similar to the one shown in the 

final image (side view). 
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2.4 Offset of edges 

1. On view control icon (LookFrom), 

hold the CTRL key to select Down 

Front Left.  

2. Change selection mode to Edge 

selection  

3. Select bottom right edge, and from 

the QUAD, under Draw tab click on 

OFFSET . Type the value 1000. 

4. OFFSET  the new line, with a 

distance of 2000. 

5. Repeat step 4, with a distance of 

1000. 
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2.5 Using Push/Pull 

We want to use some Push/Pull to create 

a more interesting shape 

1. Make sure Boundary Detection  

is enabled 

2. Move your cursor on the bottom face 

of the solid so that the boundary is 

highlighted as shown in the image on 

the right. 

3. Once you have this boundary 

selected or highlighted, use 

PUSH/PULL  and push these 

faces inward over a distance of 550. 

Thus, you should end up with 

something similar as shown in the 

final image. 

4. Let’s create boundaries on the front 

face by drawing a LINE from end 

point to endpoint to divide the top 
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from the bottom. See image for 

reference. 

5. Select boundary and use  

PUSH/PULL  and push these 

faces inward over a distance of 120  

6. Repeat step 4 on the back of the 

building. 

7. Repeat step 5 on the back boundary  

 

2.6 Using Shell 

Currently, our building is still just a box: if 

we section through our building, we see 

that it is not hollow so no spaces can be 

made inside. 

8. In the Home > Sections tab of the 

Ribbon, click SECTIONPLANE 

. You will be prompt to some options, 

select Orthographic > Front 

9. In the Home > Solid Editing tab of 

the Ribbon, click SOLIDEDIT > BODY 

> SHELL . 

10. Select the solid and press Enter. 

11. When prompted the enter the shell 

offset distance, type in 30 and press 

Enter. 

12. Hit Enter twice more to exit the solid 

editing command. 

 

 

2.7 Splitting the model into separate 

pieces 

The solid is now hollow, but it still 

consists of 1 single object. In general, we 

want to split up the model so every 

object is a separate entity. 

1. Make sure Face Selection  is 

enabled 

2. Select front Face and from the 

QUAD select MULTISLICE  . 

You will be prompt to give a distance 

value, type 30 and press ENTER. 

Then exit command. 

3. Repat STEP 2 to split the back wall. 
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4. Then split the left wall, by repeating 

STEP 2. 

5. Split the right wall, by repeating 

STEP 2 

6. Split the slab from the ground level, 

by repeating STEP 2. 

7. Split the slab from the first level, by 

repeating STEP 2 

8. To separate the slab from the first 

level from the ground level walls, 

HIDE front wall, select top face of 

the slab and use the MULTISLICE  

, type 30 and press ENTER. 

9. Make sure that the ground walls are 

also split into individual walls. Type 

30 for every SLICE that you do. 

10. To remove the opening in the slab, 

highlight any of the inner faces of 

the hole (make sure Face Detection 

 is enabled), and in the Quad 

under Model, click CONNECT WITH 

NEAREST  
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2.8 Creating some more interior walls and 

slabs 

Let’s change the connection between the 

upper floor slab and the wall highlighted 

in the image. Rotate model to show the 

opposite short wall of the narrow room.  

1. Select both solids as highlighted in 

the image, and in the Quad under 

Model tab, click L-TYPE SOLIDS 

CONNECTION  

2. Hit the Ctrl-key a few times until the 

connection is shown as in the image, 

i.e. with the slab butted against the 

wall instead of resting on top of it. 

Press Enter to accept. 

3. Highlight the top face of the wall 

(make sure Face Detection  is 

enabled), and in the Quad under 

Model, click CONNECT WITH 

NEAREST . This should connect 

this wall with the roof slab, so we 

now have to separate rooms inside 

our building. 

4. We can create some more interior 

floor slabs. We can do this by simply 

copying the existing upper floor slab 

in the Z-direction 

5. Select the entire solid of the floor 

slab and use the COPY tool to add 2 

more floors. 
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6. Move the cursor upward, type in 

4000 and hit Enter 

7. Notice that the two upper floor slabs 

are not connected to the slanted end 

wall. We can again use CONNECT 

WITH NEAREST  on the end 

faces to solve this problem. 

2.9 Making changes to the model 

Often you will have to make small 

changes after your first draft goes to the 

revision phase. Here we will discuss 

some tools that will help with the 

changes and avoid deleting solids to then 

re-model them. 

1. Let’s move some walls from the 

ground floor.  

NOTE: First make sure selection 

mode is set to 0. Type 

SELECTIONMODE, type 0 and press 

Enter 

2. Select a wall from the ground floor 

(see image) and use the 

MANIPULATOR  tool. You can 

select the MANIPULATOR from the 

QUAD under the Modify tab. 

3. Once the MANIPULATOR appears 

you can move entities by selecting 

either axis (x,y,z) from the widget. By 

selecting the x-axis and dragging it 

to the left, you can either move the 

wall visually or give an exact 

distance. Before giving a distance 

press CTRL key to Enable 

Connectivity Mode , type 300 

and press Enter. 

NOTE: When moving connecting 

entities with the MANIPULATOR, 

you have the option to move single 

entity or move entity while keeping 

connections. You can toggle options 

using the CTRL key. 

8. The connectivity can also be kept 

when rotating entities. Select the 

same wall and in the QUAD under 

the Model tab click ROTATE  . 

9. A yellow widget appears that 

indicates the rotation direction and 

axis. Move your cursor close to the 
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Exercise 3: Mechanical Parts 

On this exercise you will get to see how you can also use the direct modeling tools for mechanical 

design. We will use an existing model. The model is an excavator bucket and the following steps will 

give you an exmple of how to redesign the bucket tooth. 

right edge to rotate from the Z-axis 

and press Enter. 

10. Before typing any value, press the 

CTRL key to enable Connectivity 

Mode  and type 15. (see image 

for final result) 
 

 

3 Opening the model   

3.1 Click Open drawing. Select file 

Bucket_Assembly.dwg 

Make sure you are in the Modeling 

workspace.  

Switching between workspaces can be 

done from the status bar. If you right-click 

on the tab displaying BIM, the list of 

different workspaces will be displayed. 

Click on Modeling to switch. 

Note: Drawing units is in millimeter (mm) 

 

3.2 Create a copy of the Bucket’s Crown 

(Teeth) 

1. Select the Crown (see image) 

2. QUAD appears, select from the 

Model tab OPEN COPY  

3. This will open a new drawing called 

Crown1  
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4. From the Crown1 drawing, do Save 

As and give it a new name. (ex. 

Crown_new) 

 

 

 

3.3 Extract Profile 

1. Select face (see image).  Make sure 

Face Detection  is enabled. 

2. Extract profile (selected face from 

STEP 1) with the tool GENERATE 

BOUNDARY   from the QUAD, 

under the Draw tab. 

a. Select the back face and extract 

the profile with the GENERATE 

BOUNDARY tool. 

3. Now that the boundaries have been 

created, we can get rid of the 

original solid. This can be done by 

selecting the entire solid and from 

the QUAD>MODIFY select ERASE

 

4. Select the generated back boundary 

and 2D circle from the profile 

boundary, from the QUAD select 

HIDE. 

5. The only entity now visible is the 2D 

extracted profile (polyline). 
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3.4 Give a basic form to the new Crown 

6. Select the polyline and from the 

QUAD  select EXTRUDE . Type 

a value of 120. 

 

 

 

 

7. Select all 3 fillet (1 top and 2 in the 

bottom) and DELETE them. 

8. Let’s change the angle of the solid by 

selecting on of the bottom edge (see 

image for extra info), make sure the 

Edge Detection is enabled   

9. Use the MOVE  tool (or 

MANIPULATOR) to move the edge 

up (z-axis), input value 67. 

 

 

 

 

3.5 Introduce New Faces 

Faces will be copied to make it easier for 

further manipulation. 

1. In the command line type 

SOLIDEDIT. 

2. Type F for Face and press ENTER. 

3. Type C for Copy and press ENTER. 

4. Select front Face, press ENTER and 

select an END point as base point. 

5. Copy face through the y-axis, type 

100mm, and press ENTER 

6. You are still in the SOLIDEDIT/FACE 

command. Type C again to COPY, 

and press ENTER. Select same face 

as STEP 4 and press ENTER. 

7. You will be prompt to select a base 

point, select the same as in Step 4. 

8. The face will be copy again through 

the y-axis again, type 167, and press 

ENTER. 
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Note: Faces could also be copied with 

the MANIPULATOR. 

9. Now let’s IMPRINT the faces into the 

solid. Go to the Ribbon, Home > 

Solid Editing tab, expand the Edge 

editing and select the Imprint tool. 
10. You will be prompt to select a solid, 

select the SOLID. 
11. After selecting solid, you will be 

prompt to select an entity to 

imprint. Select one of the faces, 

press ENTER, type Y for YES and 

press ENTER. 
12. You will be prompted to select 

another entity to imprint. Select the 

second face, type Y and press 

ENTER 2x to accept and to exit 

command. 

 

 

 

3.6 Continue shaping the Crown 

Now that we have the faces imprinted into 

the solid, we can easily manipulate the 

solid to give it a more advance form. 

1. Type in the command line 

DMRECOGNIZE, type 256 and press 

ENTER. This will allow BricsCAD to 

automatically recognize the 

relations of edges between 

coincident faces. 

 

Note: You can find more info here 

Design Intent Recognition 

 

2. Select faces as in the image. 

3. From QUAD select the PUSH/PULL  

 tool to make that area of the 

crown wider. Input value 30. 

4. Select the blade’s edge, then from 

the QUAD add the FIX   

constraint. This will keep the length 

the same during rotation. 

5. Now select top middle face, and from 

the QUAD select the ROTATE  
tool (see image to know your starting 

point). Rotate downwards. Input 

value is 5. 

 

 

 

https://help.bricsys.com/hc/en-us/articles/360006548434-Design-intent-recognition
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6. Repeat STEP 5 with bottom middle 

face. Rotate upwards. Input value is 

5. 

7. Add fillets to all horizontal edges. 

This can be done by doing a window 

select. When selecting only cross the 

horizontal edges. (Make sure Edge 

Detection is enabled ) Once 

they edges are selected, use the 

FILLET  tool from the QUAD. 

Type 6, for the radius. 

 

  

 

3.7 Add Protrusion feature 

1. From QUAD select to draw a 

RECTANGLE  first insertion 

point will be in the middle of the 

blade. Dimensions 20x200 (see 

image for more info). 

Note: You can temporarily lock the 

UCS plane of the blade’s face by 

pressing SHIFT. 

2. EXTRUDE   the 2D rectangle 

upwards (make sure you select 

UNITE when extruding). Input value 

20. 
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Note: When extruding you are 

prompt to different options. The 

options can be seen in the 

command line and in the Rollover 

Tips. If you press the CTRL key, you 

can toggle through the options in 

the Rollover Tips. 

3. EXTRUDE   the left face of the 

new extrusion. Input value 20. 

4. Rotate front face of the extrusion, by 

selecting from the QUAD the 

ROTATE  tool. First select the 

bottom edge and then rotate 

inwards. Input value is 60. 

5. Rotate back face of the extrusion. 

Follow STEP 4. Rotate inwards. 

Input value is 80. 

 

  

   

3.8 Add opening 

Add an opening to the back of the tooth 

crown.  

1. Let’s bring back to view generated 

boundaries. You can do this form 

the QUAD>GENERAL select 

SHOWENTITIES. 

2. Enable Boundary Detection  

3. Select the inner rectangle. From the 

QUAD  select EXTRUDE . Move 

the cursor into the Crown and enter 

a value of 58. 

4. Extrude the circle profile through 

both sides of the Crown.  Select the 

circle. From the QUAD  select 

EXTRUDE . Move the cursor 

through both sides of the Crown, so 

there are 2 holes. 
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3.9 Add fillets 

To finish we will add two interior fillets. 

1. Select the inside lower and upper 

Edges. From the 

QUAD>MODEL>FILLET. Enter a 

value of 6. 

 

 

 

 


